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About this Guide

This guide describes the G2 Graphical User Interface Development Environment
(GUIDE), a development tool that enables you to create graphical user interfaces
for G2 applications.

Users of this guide also need the G2 GUIDE/UIL Procedures Reference Manual,
which describes the G2 GUIDE User Interface Library (GUIDE/UIL).
GUIDE/UIL provides an application programmer’s interface (API) to procedures
that control dialogs and other elements of a graphical user interface.

Audience

This guide is written for GUIDE application developers. It addresses application
developers as “you,” and refers to end users of GUIDE applications as “the user”
or “users.”

Xvii



Organization

This guide is divided into five parts and 26 chapters:

Title

Description

Part 1

Introduction

Introduction to G2 GUIDE

Getting Started

Summarizes how to create and
use a GUIDE user interface for a
G2 application.

Describes preliminary steps for
starting and running GUIDE,
and explains how to avoid
problems that can prevent you
from running or saving your
GUIDE application.

Part 11

Creating a User Interface

3

Xviii

Generating Master Dialogs

Building Master Dialogs

Using UIL Controls on a Workspace

Customizing Dialogs

Launching Dialogs

Describes how to use the GUIDE
Dialog Generator to generate a
master dialog for viewing and
editing attributes of a particular
user-defined class.

Describes how to use the G2
GUIDE Palette and other GUIDE
tools to build customized dialogs
for viewing and editing the class-
specific attributes of user-
defined classes.

Ilustrates several ways to use
UIL controls on a workspace,
without incorporating them into
a dialog.

Describes how to edit and
customize GUIDE dialogs.

Describes how to launch a dialog
from an action button, a user-
menu choice, a user-defined
procedure, a push button, or a
rule.



Title

Organization

Description

Building Master Dialogs

Describes how to use the G2
GUIDE Palette and other GUIDE
tools to build customized dialogs
for viewing and editing the class-
specific attributes of user-
defined classes.

Part I11

Editing User Interface Components

9

10

11

12

13

14

15

16

Push Buttons

Radio Buttons

Check Buttons

Toggle Buttons

Edit Boxes, Combo Boxes, and Spin
Controls

Scroll Areas and Message Objects

Sliders

Text Objects

Describes how you can create
and edit push buttons to run
specific sets of actions on
dialogs, such as opening and
closing them, or updating or
concluding their values.

Describes how to create and edit
groups of radio buttons to
provide users with sets of
mutually exclusive choices.

Describes how to create and edit
groups of check buttons, in
which users can select any
number of choices.

Describes how to create and edit
toggle buttons, which represent
two mutually exclusive choices.

Describes how to create and
customize edit boxes, combo
boxes, and spin controls.

Describes how to create and edit
scroll areas and message objects.

Describes how to use and edit
Sliders.

Describes how to create and edit
text objects, which display read-
only text.

Xix



Title

Description

17

18

Title Bars, Borders, and Separators

Navigation Buttons and Other Tools

Describes how to use title bars,
border, and separators to
provide your user interface with
visual definition.

Describes how to add navigation
buttons, help buttons, print
workspaces, and the GUIDE

garbage pail to workspaces.

Part IV

Advanced Features

XX

19

20

21

22

23

24

Formats and Validation Criteria

Specitying Source
and Target Objects

Creating Temporary Storage Objects

Methods, Actions, and Callbacks

Help Dialog

Creating Custom UIL Subclasses

Describes how to create and edit
reusable formats for edit boxes,
message objects, and text objects.

Describes how to specify the
objects from which the graphical
objects on a dialog are updated
and to which the graphical
objects conclude their values.

Describes how to create and use
temporary storage objects, which
you can use when you process
data while it is being updated
into or concluded from a dialog,.

Describes how to create and use
UIL methods, actions, and
callbacks.

Describes the GUIDE help
facility.

Describes how to create
customized subclasses of system-
defined UIL classes provided
with GUIDE.



Conventions

Description

Title
25 Specifying the Colors of UIL Objects
26 Upgrading GUIDE Applications
Conventions

Describes how to create reusable
objects called configurations,
which specify the colors of the
different regions of the graphical
components in your user
interface.

Describes how to modify dialogs
and other components of a user
interface created with earlier
versions of GUIDE, to take
advantages of the features
introduced in newer versions.

This guide uses the following typographic conventions and conventions for

defining system procedures.
Typographic

Convention Examples

Description

g2-window, g2-window-1,
ws-top-level, sys-mod

User-defined and system-defined
G2 class names, instance names,
workspace names, and

module names

history-keeping-spec, temperature

User-defined and system-defined
G2 attribute names

true, 1.234, ok, “Burlington, MA”

G2 attribute values and values
specified or viewed through
dialogs

Main Menu > Start
KB Workspace > New Object
create subworkspace

Start Procedure

G2 menu choices and button labels

XXi



Convention Examples

Description

conclude that the x of y ...

Text of G2 procedures, methods,
functions, formulas, and
expressions

new-argument

User-specified values in
syntax descriptions

text-string

Return values of G2 procedures
and methods in syntax
descriptions

File Name, OK, Apply, Cancel,
General, Edit Scroll Area

GUIDE and native dialog fields,
button labels, tabs, and titles

File > Save GMS and native menu choices
Properties
workspace Glossary terms

c:\Program Files\Gensym\

Windows pathnames

/usr/gensym/qg2/kbs

UNIX pathnames

spreadsh. kb

File names

g2 -kb top.kb

Operating system commands

public void main() Java, C and all other external code

gsi start

Note Syntax conventions are fully described in the G2 Reference Manual.

Procedure Signatures

A procedure signature is a complete syntactic summary of a procedure or
method. A procedure signature shows values supplied by the user in italics, and
the value (if any) returned by the procedure underlined. Each value is followed by
its type:

g2-clone-and-transfer-objects
(list: class item-list, to-workspace: class kb-workspace,
delta-x: integer, delta-y: integer)
-> transferred-items: g2-list
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Customer Support Services

You can obtain help with this or any Gensym product from Gensym Customer
Support. Help is available online, by telephone, by fax, and by email.

To obtain customer support online:
2 Access G2 HelpLink at www. gensym-support.com
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* Query for Bugs, Suggestions, and Resolutions.

To obtain customer support by telephone, fax, or email:

2> Use the following numbers and addresses:

Americas Europe, Middle-East, Africa (EMEA)
Phone (781) 265-7301 +31-71-5682622
Fax (781) 265-7255 +31-71-5682621
Email service@gensym.com service-ema@gensym.com
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Introduction

Chapter 1: Introduction to G2 GUIDE

Summarizes how to create and use a GUIDE user interface for a G2 application.

Chapter 2: Getting Started

Describes preliminary steps for starting and running GUIDE, and explains how to avoid
problems that can prevent you from running or saving your GUIDE application.






Introduction to
G2 GUIDE

Summarizes how to create and use a GUIDE user interface for a G2 application.

Introduction 3

Using a GUIDE User Interface 7
Creating a GUIDE User Interface 12
UIL Methods, Actions, and Callbacks 24

gensym.

Introduction

The G2 Graphical User Interface Development Environment (GUIDE) enables
you to create graphical user interfaces (GUI’s) for G2 applications.

You construct a GUIDE user interface using graphical components called
UIL controls.

GUIDE supports different classes of UIL controls for different purposes:

* Some classes of UIL controls, such as edit boxes, buttons, and scroll areas,
enable users to view and edit the data stored in object attributes. The different
classes are suitable for viewing and editing different types of data.

® Other classes of UIL controls, such as borders and separators, enable you to
organize a user interface visually.

You can add UIL controls to interactive dialogs, which you design using GUIDE.
You can also add UIL controls to workspaces of your G2 application.



Dialogs for Viewing and Editing Attribute Values

GUIDE interactive dialogs can add structure and flexibility to your user interface.
Many of the more powerful features of GUIDE are available only through dialogs.

Useful Features of Dialogs Created with GUIDE

G2 applications store information that is valuable to users in class-specific
attributes of G2 objects. Users can edit these attribute values directly in the
attribute tables of G2 objects.

Through the user interface that you create using GUIDE, users can view and edit
the information stored in these attributes.

However, enabling users to view and edit attribute values through dialogs has
significant advantages over requiring them to view and edit attributes directly in
attribute tables:

® Youcan create dialogs that enable users to view and edit attribute values from
several different G2 objects.

* You can validate the changes that users make to attribute values, using criteria
that you specity.

® You can add push buttons to a dialog that enable users to perform operations
such as:

- Updating the display in the dialog with current attribute values
- Modifying attribute values using the contents of the dialog
- Opening or closing the dialog
- Opening another dialog
® You can specify the format used to display attribute values.

* You can process attribute values before you display them in a dialog. For
example, you can find the average value of a given attribute in several
different G2 objects and display this average in a dialog.

®* You can take advantage of GUIDE/UIL features that enable you to specify
any number of different natural language versions of the text in labels of UII
controls on dialogs.

Representing Different Types of Data

UIL provides different classes of UIL controls that you can use to represent
attribute values in different ways. Each class is appropriate to a particular type of
data. For example, edit boxes are suitable for displaying and editing text values,
and scroll areas are suitable for displaying lists and arrays of values.



Introduction

The following figure illustrates a G2 object and the UIL controls used on a dialog
to view and edit the object’s attributes.

AN

CARS

4

object definition

G2 object of
class cars

MY-OLD-CAR

MY-OLD-CAR, a cars

Notes

oK

Names

MY-OLD-CAR

Make

hash

Model

rambler

Year

1966

Used

false

Color

brown

Extras

a text-array

Make:lNASH,\ i edit
boxes

Model: | RAMBLER
Year: | 1966 toggle
button

[L] Used fals

Color; # Brown radio
- Green buttons
~ Blue

scroll
area

Extras:
air-conditioning |;

power-brakes E

power-steering

radio

K

Cancel |

The dialog named Cars Information in the figure above illustrates how different
classes of UIL controls can be used to represent class-specific attributes of a G2

object:

* The attributes Make, Model, and Year contain text. They are represented on
the dialog by edit boxes. Each edit box displays the current value of the
corresponding attribute. A user can change the attribute value by editing the

contents of the edit box.

* The Used attribute can have one of two mutually exclusive values, true or
false. It is represented by a toggle button. The current state of the toggle
button indicates the current value of the used attribute. A user can change the
value of the used attribute by toggling the used button on or off.

* The Color attribute can have one of three mutually exclusive values, Brown,
Blue, or Green. It is represented by a group of three radio buttons. Each
button in the group represents one of the possible values of the Color
attribute. The current value of the Color attribute is indicated by the radio
button that is selected; only one button in a radio button group can be selected
at one time. A user can change the value of the Color attribute by selecting a

different radio button.



* The Extras attribute references an array of text elements. The text elements can
be used to specify features such as power steering, power brakes, air
conditioning, or radio.

On the dialog, the Extras attribute is represented by a scroll area. The scroll
area contains message objects representing the elements of the text array. The
figure above illustrates how the scroll area looks when the text array contains
the elements air-conditioning, power-steering, and radio.

User Interface Components on Workspaces

You can add any UIL control directly to a workspace of your application, where
you use it without the support of a GUIDE interactive dialog. However, you give
up much of the structure and flexibility provided by dialogs when you use UIL
controls on workspaces, for example, you cannot use push buttons to perform
operations on UIL controls that are not on a dialog.

For examples of how to use UIL controls on workspaces, see Using UIL Controls
on a Workspace.

Online Examples and Tutorial: the Demo KB

GUIDE is shipped with a demo knowledge base, guidemo. kb, that contains:

*  Working examples of GUIDE dialogs, and other important features of a
GUIDE user interface.

You can look at these examples as illustrations of how a GUIDE user interface
can be designed. You can also copy and modify examples to use in your own
applications.

* Anonline tutorial that shows you how to use GUIDE to create a user interface.

To open the main workspace of the demo knowledge base:
1 Click the Help System navigation button in the GUIDE palette.
This button has a question mark (?) on it. The GUIDE Help dialog appears.

2 Click the navigation button labeled UIL Examples to display the main
workspace of the demo knowledge base.

Note If you have not loaded guidemo. kb, you see a message informing you that
guidemo.kbis not loaded. If you see this message, pause your KB, merge in
guidemo. kb (select the automatically resolve conflicts option when you
merge), and restart your knowledge base.
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Programmatic Support for GUIDE: GUIDE/UIL

GUIDE is supported by the G2 GUIDE User Interface Library (GUIDE/UIL).
GUIDE/UIL provides an application programmer’s interface (API) to procedures
that perform basic operations on dialogs and UIL controls.

You can create working dialogs without writing code or using UIL procedures
explicitly.

However, you can extend the basic capabilities of GUIDE by using UIL
procedures in customized methods, actions, callbacks, and procedures. For

information about how to create customized versions of these procedures, see
Methods, Actions, and Callbacks.

This guide contains examples of the use of UIL procedures in the following
chapters or sections:

* Launching Dialogs

¢  Multiple Column Scroll Areas

* System-Defined Dialogs

® (Creating Temporary Storage Objects

The demo knowledge base also contains an extensive set of examples of the use of
UIL procedures. For information about how to access the demo knowledge base,
see Online Examples and Tutorial: the Demo KB.

For detailed information about GUIDE/UIL, see the G2 GUIDE/UIL Procedures
Reference Manual.

Using a GUIDE User Interface

Users of a GUIDE user interface need to be able to do the following things:
* Launch dialogs

* Update the values displayed in a dialog with current information

* Edit the values in a dialog

® Send the values in a dialog back to the application

® C(lose dialogs

GUIDE enables you to incorporate all of these features into the user interface that
you construct using GUIDE.



Launching Dialogs

Users of a GUIDE user interface can launch dialogs in the following ways:

* By selecting a user-menu choice from the menu of a G2 object whose
attributes they want to view or edit

* By clicking a G2 action button

® By clicking a UIL push button in a dialog that is already open

® By executing a procedure, action, or rule

The following figure illustrates some of the ways that users can launch dialogs in
a GUIDE user interface:

A

CARS

[

MY-0LD-CAR

Rent a Carl

table
transfer
name
clone
rotate/reflect »- Make: | MASH
change size
color - Model: | RAMBLER
delete Year [1988
lift to top [_] Used false
drop to bottom More Rental Options
disable Color: # Erown
describe < EiEn Extras: =]
create subworkspace < Be Cl
move. . .
edit array. . . OK | More Options... I
edit cars. . . -
L
OK | Apply I Cancel




In the figure above:

Using a GUIDE User Interface

The user menu choice edit cars on the menu of a G2 object named rambler
launches the dialog Cars Information.

The edit cars user menu choice starts a UIL procedure that launches the
dialog, as shown in the following table:

| an user-menu-choice |

Notes

USER-MENU-CHOICE-XXX-510: OK

Authors

none

Names

none

Label

edit-cars.-.~.

Applicable class

cars

Condition

none

Action

start uil-start-or-refocus-dialog ('Cars
Information’, the item, this window)

Action priority

The G2 action button labeled Rent a Car launches the dialog Cars

Information.

The Rent a Car button starts a UIL procedure that launches the dialog, as
shown in the following table:

| RENT-CAR, an action-button |

Notes

oK

Names

RENT-CAR

Label

'Rent a Car'

Action

start uil-start-dialog ("Cars-information’,
‘rent a car', this window)

Action priority

The More Options push button in the Cars Information dialog launches the
More Rental Options dialog.
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Launching Dialogs from within Other Dialogs

As the example in the figure above indicates, users can open dialogs from within
other dialogs. Users can click a push button in one dialog, the parent dialog, to
open another dialog, the child dialog. Parent and child dialogs that you associate
in this way are called cascaded dialogs. For information about how to create
cascaded dialogs, see Creating Systems of Cascaded Dialogs.

Controlling Dialogs with Push Buttons

Push buttons enable users to perform a variety of operations on dialogs, such as
launching and closing them, or updating or concluding the values of the UIL
controls on the dialogs.

These operations are performed by procedures known as actions. When a user
clicks on a push button, a set of actions associated with that push button is run on
a specified dialog. This can be the dialog that contains the push button, or another
dialog. You can edit a push button to specify the actions that are run when a user
clicks on it, and the dialog on which the actions are run.

By default, each dialog that you create contains OK, Apply, and Cancel buttons
that run appropriate actions on the dialog:

* The OK button applies the changes that the user has made in the dialog and
closes the dialog.

* The Apply button applies the changes but leaves the dialog open.
* The Cancel button closes the dialog without applying the changes.

GUIDE provides an extensive set of system-defined actions that perform common
operations, such as opening and closing dialogs, and updating or concluding
their contents. You can also create customized actions to perform customized
operations.

You can edit any push button to make it run any system-defined or user-defined
action.

Selecting UIL Controls

Users can select any UIL control by clicking on it. Clicking on different UIL
controls has different effects:

* Clicking on a button selects that button. Clicking on a radio button also
deselects any other radio button in the same group.

* C(licking on a message object in a scroll area selects the message object.

* C(licking on a push button activates the push button, causing the callback
procedure associated with the button to run. The callback procedure can run a
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set of actions on a specified dialog, or it can run a procedure or procedures to
perform other operations required by your application.

Clicking on an edit box starts an edit session on the contents of the edit box
and ends the edit session on any other edit box in the same dialog.

Users can navigate through the editable text fields (edit boxes) in a GUIDE dialog
using the Tab key or other key. You can edit the sequence in which the Tab key
navigates through edit boxes.

Scrolling a Scroll Area

You use the scroll bar on a scroll area to scroll its contents up or down. To do this,
you can click the following parts of a scroll bar: the scroll down arrow, the scroll
bar body, the scroll up arrow, or the scroll thumb.

The following figure illustrates the parts of a scroll bar:

scroll up arrow
:| i

scroll bar body

scroll thumb

-y scroll down arrow

=l

Clicking on the parts of the scroll bar has the follow effects:

Clicking on the scroll up arrow scrolls message objects down one line.
Clicking on the scroll down arrow scrolls messages objects up one line.

Clicking on the scroll bar body above the scroll thumb scrolls message objects
down one page.

Clicking on the scroll bar body below the scroll thumb scrolls message objects
up one page.

Dragging the scroll thumb up moves message objects down. Dragging the
scroll thumb down moves message objects up.

11



Creating a GUIDE User Interface

GUIDE provides all the tools you need to create a user interface that meets the
requirements of your G2 application.

Using GUIDE, you can:

12

Generate master dialogs automatically.

A master dialog is a template for the dialogs that users see and use when they
run your G2 application. The dialogs that users see and user are called copy
dialogs. GUIDE creates copy dialogs by cloning master dialogs that you
create.

Build customized master dialogs.
Add UIL controls to workspaces.
Edit the appearance and behavior of UIL controls.

Write customized procedures for performing common operations such as
opening and closing dialogs, or updating and concluding the values that they
contain. You use your customized procedures in place of system-defined UIL
procedures that perform these operations by default.

Access useful information about UIL procedures.

Generating Master Dialogs

The GUIDE Dialog Generator enables you to generate master dialogs for viewing
and editing the class-specific attributes of particular user-defined classes.

In the GUIDE Dialog Generator, you select the class-specific attributes that you
want users to be able to view and edit. In the generated master dialog, each of the
attributes that you select is represented by a UIL control through which users can
view and edit the value of that attribute.
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For example, the following figure illustrates an automatically generated GUIDE
dialog that enables users to view and edit the class-specific attributes of an
instance of the user-defined class cars:

,_fi object definition

CARS

E G2 object Make: | MasH
of class cars
MY-OLD-CAR Model: |RAMBLER
= | 196k
MY-OLD-CAR, a cars Year: |

[L] Used false
Notes | OK
Color; # Brown
Mames | MY-OLD-CAR ~ Green
Make | nash v Blue
Extras: — ——
Model | rambler air-conditioning |;
power-brakes |:
Year | 1966 W
Used | false radio ||
L~]
Color | brown
oK Appl Cancel
Extras | atext-array | A |

The dialog titled Cars Information contains a UIL control for each class-specific
attribute of objects of the class cars such as my-old-car.

To view attribute values of my-old-car, a user opens the dialog. When the dialog is
displayed, the edit boxes are updated with current values of the corresponding
attributes.

To edit attribute values of my-old-car, a user enters values into the edit boxes
associated with the attributes and clicks the OK or Apply button. This writes the
values in the edit boxes to the corresponding attributes.

Users can view and edit the attributes of any other G2 object of the class cars,
using the Cars Information dialog.

By default, the GUIDE Dialog Generator chooses an appropriate kind of UIL
control to represent each attribute, depending on the data type of the attribute.
For example, the GUIDE Dialog Generator uses edit boxes to represent text
attributes and scroll areas to represent attributes that reference lists or arrays. You
can override these defaults and choose other kinds of UIL controls to represent
particular attributes.

13



The following figure illustrates a GUIDE dialog that includes most UIL controls

provided by GUIDE:
title
bar I & il )il
text
border Renter Make of Car object
. (o] scroll
ot { pdarss: [Amiy, oA
OX
Stutz Bearcat
Phone: |123-4567
Stanley Steamer — mgssage
= object
Options Color of Car
check —— (W] Radio # Black rba::;gn
button (L] Seat cushions < White
Glove compartment
text P . Red icon
toggle Insured for Theft I Insured for Collision — toggle
button button
text oK | L] Cancel icon
| h
push pus
button button
separator

The following table describes the UIL controls that you can use to create a user

interface:
UIL Controls

UIL Control Description

Title bar A label for the dialog that appears at
the top of the dialog subworkspace.

Push button Provides users with control over
dialogs. Push buttons can perform
operations such as updating or
concluding the values in a dialog,
closing a dialog, or opening another
dialog.

Edit Box, Spin Control Displays values that users can edit.

Entry Box, Combo Box Spin control entry boxes and combo

14

boxes were introduced in GUIDE 6.0
and are not shown above.
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UIL Controls
UIL Control Description
Check button Used in groups called check boxes.

Each check button has one value when
selected and a different value when
unselected. Users can select any
number of check buttons in a check
box.

Radio button Used in groups called radio boxes.
Each radio button has one value when
selected and a different value when
unselected. Users must select one and
only one radio button in a radio box.

Toggle button Used individually, rather than in
groups. Each toggle button has one
value when selected and another
value when unselected.

Text object Displays text. The text can be updated
by your application, but users cannot
edit it.

Scroll Area and A scrollable field containing one or

Message Object more message objects. Each message

object displays text. Your application
can update message objects. Users can
select message objects but cannot edit
their contents.

Sliders A graphical object with a pointer that
moves along a horizontal or vertical
track. The position of the pointer
indicates the current value of the
slider. Users can change the value by
dragging the pointer.

Border A box that surrounds a workspace,
edit box, or text object, providing
visual definition.

15
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UIL Controls

UIL Control Description

Separator A vertical or horizontal line, providing
visual definition.

Navigation button Buttons that users can click to move
from one workspace to another.

Note: Do not attempt to use
navigation buttons in dialogs that you
create using GUIDE.

Building Customized Master Dialogs

For some purposes an application can require dialogs that are more fully
customized than dialogs that you create using the GUIDE Dialog Generator. The
GUIDE palette is the tool that enables you to create fully customized master
dialogs. For detailed information about how to build a customized dialog, see
Building Master Dialogs.

Using the GUIDE palette, you can:

® Create master dialogs.

* Add UIL controls to existing master dialogs.

* Change the layout and appearance of master dialogs.

* Add UIL controls directly to a workspace, without incorporating them into
a dialog.



Features of the GUIDE Palette

Creating a GUIDE User Interface

The GUIDE palette is a workspace that includes basic tools for developing a
GUIDE user interface. The GUIDE palette looks like this:

——— Opens GUIDE

Control Panel

. Opens GUIDE

Opens GUIDE
Help dialog GUIDE 8.3 Rev. 0
E Mode...| About... |
Nawvigation Buttons
navigation — - (S s Sl
buttons,
print icon, Selection Buttons
trash can ¢ — B—
g—| <& |[B=|E
Toggle Button Push wﬁ
Text Edit Boxes
Message
] B
Scroll Areas
Icons for o I
creating ¥ ¥
master = ]
dialogs and =
UIL controls Dialogs ﬁ
TITLE | [ooo| [ooo |
Borders Separators
—
i | | —
FIEIEIE —
Sliders
= =

Opens More
Options palette

E More Options

Information
Dialog

Using Icons for Dialogs and UIL Controls

To create a master dialog:

1 Click the dialog icon in the GUIDE palette.
Clicking on the dialog icon clones a master dialog. You then click the
workspace where you want to put the master dialog. Clicking on the
workspace transfers the cloned dialog to that workspace.

2

Add UIL controls to the new master dialog. To do this, you first open the

subworkspace of the dialog. Then you add UIL controls to the subworkspace

17
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by clicking on their icons on the GUIDE palette and then clicking on the
subworkspace.

The following figure illustrates how to create a master dialog and add a UIL
control to it using the GUIDE palette:

Master Dialog Title
Label: |

OK | Apply | Cancel

subworkspace of master dialog

MY-WORKSPACE

| | |

master dialog

Note The title bar of every master dialog contains the word Master. If you do not see
Master in the title bar of a dialog subworkspace, that dialog is not a master and
you cannot edit it.

Using the GUIDE Control Panel

The GUIDE Control Panel enables you to select a user mode for running GUIDE,
and to specify the default window style and size of the UIL controls that you
create using the GUIDE palette.

You open the GUIDE Control Panel by clicking on the Mode button in the GUIDE
palette.

You can also open the GUIDE Control Panel by selecting the following choice
from the GUIDE menu bar:

Tools > GUIDE Control Panel



The GUIDE Control Panel looks like this:

GUIDE Control Panel

Select Style . . . .. Size
# Motifm & Small
& WindowsT # Medium
- Large
Select Mode
~ Build Mode

 UserMode: |

4 Administrator Mode

QK | Apply | Cancel |

Using the GUIDE Help Dialog

Creating a GUIDE User Interface

You access the GUIDE Help dialog by clicking on the question mark (?) icon in the
GUIDE palette. The main dialog of the GUIDE Help dialog looks like this:

<% UIL Procedure Lookup Facility E

e UIL Methods, Actions and Callbacks E
<!> GUIDE Dialog Generator
v UIL Examples

% GUIDE Tutorial

B HyHER

Y GUIDE Debugging Tools

| Dismiss |

GUIDE Help

19
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You can click the buttons in the GUIDE Help dialog to:

Display information about each system-defined UIL procedure. The
information includes a synopsis of the procedure’s arguments and return
values.

Display information about UIL methods and invoke editors that help you
create customized methods and actions to use in place of the system defined
methods, actions, and callbacks.

Invoke the GUIDE Dialog Generator.

Open a workspace that contains working examples of dialogs and UIL
controls. This workspace contains the examples in guidemo. kb.

Run the online GUIDE tutorial, which leads you through the basic steps of
creating a user interface with GUIDE.

Start the GUIDE Debugging Utility, which enables you to display messages
that help you debug your GUIDE application.

Using More Options

Clicking on the More Options navigation button in the GUIDE palette opens the
More Options palette:

KB Workspace

E More Options Help File

Location Icon

Print YW orkspace Dialog
FRINT.

Faormat Specification

FIIII”IT]EIt

Action Description Array

Field Edit Style

EDIT

Configurations...

GFR Text Resource
Group Icon

Enable User Menu Choices
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The More Options palette contains icons that you can select and drop on a
workspace to create:

A help file location icon that you can click to open a table listing the file name
and current pathname of the help system file, which lists the procedures in the
public API to UIL. For information about this file, see Finding the UIL Help

System File.
A Print button. Users can click the Print button to open the Printer Setup

Dialog. In this dialog, users can specify options for printing the workspace
that contains the Print button.

A reusable Format to specify aspects of format such as the use of quotation
marks, capitalization, and hyphens. You can apply formats to edit boxes, text
objects, and message objects. Formats can also specify validation criteria for
edit boxes. For information about formats, see Formats and

Validation Criteria.

An action description array. An action description array is an array of
operations that can be run on a dialog. You can invoke an action description
array on a dialog by invoking the procedure uil-control-dialog-callback. For
information about action description arrays, see Controlling Dialogs with
Actions.

A reusable field edit style that specifies the behavior of the editor for edit
boxes. You can apply field edit styles to individual edit boxes. For information
about field edit styles, see Edit Styles for Edit Boxes.

A Configurations button that you can click to open the Create Configuration
dialog. For information about how to create and use configurations, see
Specifying the Colors of UIL Objects.

A GFR Text Resource Group icon. The subworkspace of this icon contains a
default English GFR Local Text Resource. Generic dialogs derive the text of
their labels from GFR (Gensym Foundation Resources) local text resources.
For information about how to edit GFR Local Text Resources to specify
GUIDE label text, see Editing the Label Text of Generic Dialogs.

An Enable User Menu Choices button, which you can click to enabled
GUIDE/UIL user menu choices.

GUIDE/UIL user menu choices end in a period (.), to distinguish them from
G2 user menu choices. Always use the GUIDE/UIL user menu choice, rather
than its G2 equivalent, to perform an operation on a UIL object. For example,
always use the menu choice clone. (rather than clone) to clone a dialog.

21
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Note

How to Find What Version of GUIDE You Are Using

To find out what version of GUIDE you are using, open the GUIDE Information
dialog;:

GUIDE Information

Dismiss

You can open this dialog in either of two ways:
® C(lick the About navigation button in the GUIDE palette.
* Select Help/ About GUIDE from the GUIDE menu bar.

Editing UIL Controls

GUIDE provides graphical editors that enable you to edit the appearance and
behavior of dialogs and of UIL controls, such as edit boxes, push buttons, and
scroll areas.

You can also edit the attributes of UIL controls directly, in their attribute tables.
You may find it convenient to edit UIL controls through their attribute tables
when you are debugging an application. However, using the graphical editors to
edit UIL controls reduces the possibility of error and is the recommended method
for most purposes.

Editing the Behavior and Appearance of Dialogs and UIL Controls

You can edit the appearance and run-time behavior of dialogs and UIL controls,
using specialized graphical editors. Each class of UIL control has its own
graphical editor, which is described in a separate chapter in this guide. For
example, the object editor for push buttons is described in Push Buttons.
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Specifying Source and Target Attributes of UIL Controls

When you add UIL controls to a dialog by means of the GUIDE palette, you must
edit each UIL control to specify its source attribute and target attribute.

* The source attribute is the class-specific attribute of a G2 object (the source
object) whose value is reflected in the UIL control.

* The target attribute is the class-specific attribute of a G2 object (the target
object) to which the UIL control concludes its value.

GUIDE provides two graphical editors that enable you to specify source attributes
and target attributes: Edit Source Object & Attribute and Edit Target Object &
Attribute.

When you generate a dialog automatically, GUIDE automatically sets the source
and target attributes of the UIL controls on the dialog to the corresponding
attributes in the G2 class for which you are creating the dialog. If necessary, you
can change the defaults source and target attribute, using the Edit Source Object &
Attribute and Edit Target Object & Attribute editors.

Creating UIL Controls with Customized Appearance and Behavior

For some purposes, you may want to create UIL controls with a different
appearance or behavior from the UIL controls that you can create using the
GUIDE Dialog Generator or the GUIDE palette. For example, you may want to
customize the following aspects of UIL controls:

e Color

* Size

* Behavior

® User restrictions

You customize UIL controls by creating customized subclasses of controls, or by
creating customized configurations.

Creating Subclasses of UIL Controls

Every UIL control is an instance of a system-defined UIL class. For example, edit
boxes are instances of the class uil-edit-box, and scroll areas are instances of the
class uil-scroll-area.

To create a large number of UIL controls with a customized appearance and
behavior, you can:

* Create a subclass of the system-defined UIL class for that kind of control.
* Edit this subclass to specify the appearance and behavior that you want.

® Create UIL controls from this subclass. Each of these UIL controls will have
the customized appearance.

23



For information about how to create customized subclasses, see Creating Custom

UIL Subclasses.

Applying Customized Configurations to UIL Controls

The color or colors of a UIL control is specified by a G2 object known as a
configuration. Each class of UIL controls has a default configuration.

You can customize the colors of all UIL controls of a particular class by editing the
configuration that is applied to those controls. You can also create customized
configurations and apply them to individual UIL controls.

For information about how to create customized UIL controls, see Creating
Custom UIL Subclasses.

UIL Methods, Actions, and Callbacks

24

GUIDE uses three specialized kinds of procedures to perform operations required
for creating and using a GUIDE user interface. These procedures are called UIL
methods, actions, and callbacks. GUIDE/UIL provides an extensive set of
system-defined methods, actions, and callbacks.

When you create a user interface, GUIDE automatically ensures that the interface
references an appropriate system-defined procedure for every common
operation. You can create and use a GUIDE user interface without modifying the
set of system-defined methods, actions, and callbacks that the interface references
by default.

However, for some purposes, your application may need to use customized
methods, actions, or callbacks to perform specialized processing. For detailed
information about how to create and use customized methods, actions, and
callbacks, see Methods, Actions, and Callbacks.
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Introduction

The G2 User Interface Developer’s Environment (GUIDE) is a knowledge base
(KB) module, whose name is guide. All components of GUIDE are identified by
either the public gui- prefix or private _gui- prefix.

Installing GUIDE

26

You install GUIDE by merging it into any modularized knowledge base. When
you merge GUIDE, its required modules are automatically loaded into G2.

The filename of GUIDE is guide. kb. The default location of this KB is the utils
subdirectory of the kbs directory under the g2 directory.

How you merge GUIDE into a KB depends on whether your KB already has a
version of GUIDE.

Merging GUIDE into Your KB for the First Time

To merge GUIDE into a knowledge base (KB) that has never included GUIDE:
1 Pause your KB.
2 Choose Main Menu > Merge KB to display the Load KB workspace.

The merge in this KB option is enabled on the workspace.

3 Specify the location of the guide. kbfile and click End.

Tip When merging GXL, let G2 resolve conflicts by enabling the automatically

resolve conflicts option.

When you merge GUIDE into your KB, it is not a required module unless it is
specified in the Module Information table of your KB.

To make GUIDE a required module:

1 Choose Main Menu > System Tables > Module Information.

2 Specify GUIDE as a directly required module of either:
® The module for which you are creating a GUIDE interface, or
* The top-level module of your application.

For more information on merging KBs and making a KB a required module, see
the G2 Reference Manual.
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Merging GUIDE into a KB with an Earlier Version

To merge GUIDE into a KB that has a previous version of GUIDE:

1 Move your current GUIDE modules from the directory that contains your
application into a separate directory.

2 Place this version of the GUIDE modules into the directory that contains your
application.

3 Pause your KB.
4 Choose Main Menu > Merge KB to display the Load KB workspace.
The merge in this KB option is enabled on the workspace.

5 Specify the location of the guide.kb file and click End.

Tip When merging GXL, let G2 resolve conflicts by enabling the automatically
resolve conflicts option.

6 Restart the KB.
7 Choose Main Menu > Save KB to save your application modules.

The next time you load these modules, it will not be necessary to resolve conflicts.

For information on upgrading GUIDE applications, see Upgrading GUIDE
Applications.

Verifying Your Version of GUIDE

To verify that the version of GUIDE/UIL that you have merged is the one that
you want, you can open the Guide Version Information bin, which contains a
version information object specifying the version number of the currently loaded

GUIDE/UIL.

To open the Guide Version Information bin:
1 Choose Main Menu > Inspect and enter:
go to guide-storage-bins

The Guide Application Components bin appears.
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2 Click the Guide Version Information button to display the Guide Version
Information bin. For example:

KB “Workspace

E Guide Application Components
(] Guide Bins

E Guide Configurations

E Huide Yersion Infarmation
E Guide Specific Classes

KB “Workspace

E Guide Yersion Information

"GUIDE-8.3 Rew. 0"
GUIDE-CURRENT-YERSION-INFORMATION-CBJECT

License Requirements

You can build and run a GUIDE user interface under any G2 license. GUIDE/UIL
also works with all licenses.

The GUIDE/UIL Module Hierarchy

When you merge GUIDE/UIL into your KB, its required modules are
automatically loaded into G2. The following table describes these modules:

Module File Name Contents

g2cuidev g2cuidev.kb Definitions and API support for the G2
Developer’s Interface tools. For
information about these tools, see the
G2 Developer’s Interface User’s Guide.

g2uiprnt g2uiprnt.kb The print workspace dialog. You can
customize printer selection, papersize,
orientation, margins, and other print
options. For information on using its
features, see Printing GUIDE

Workspaces.
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The GUIDE/UIL Module Hierarchy

Module File Name Contents

afr gfr.kb Definitions and API support for the G2
Foundation Resources (GFR) utility.

gms gms. kb The G2 Menu System. For information
about GMS, see the G2 Menu System
User’s Guide.

gold gold.kb The G2 Online Documentation
(GOLD) system. For information
about GOLD, see G2 OnLine
Documentation User’s Guide.

guicolor guicolor.kb The color selection dialog.

guidata guidata.kb Support for editing attributes
configured as lists or arrays.

guide guide.kb A top-level module that requires
modules containing all GUIDE editors
and the front-end to all UIL objects.

guidelib gquidlib.kb The standard dialogs for editing
attributes of UIL controls.

guidemo guidemo. kb Online examples and tutorial.

guidesa guidesa.kb class definitions for Scroll Areas.

quigfr quigfr.kb A graphical user interface and
supporting API for the
internationalization of dialogs.

guimove guimove.kb A move dialog, in which you can
make adjustments to the X and Y
positions of any G2 object.

guislide guidslide.kb  Class definitions for Slider objects
(uilslide) and an API to these classes.

guitools guitools.kb Includes the modules guicolor,
guimove, guigfr, and guidata.

sys-mod sys-mod. kb The library of G2 system procedures.

uil uil.kb General API to all UIL objects. The

UIL module is required for use of a
GUIDE user interface.
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Module File Name Contents

uilcombo uilcombo.kb Class definitions for combo boxes and
an API to these classes.

uildefs uildefs.kb Definitions for UIL objects.

uillib uillib.kb The UIL machinery not contained in
uilsa or uilslide.
uillib depends upon the GFR KB for its
internationalization. For information
about internationalization, see the
G2 Foundation Resources Reference
Manual.

uilsa uilsa.kb Internal support for Scroll Areas.

uilslide uilslide.kb Internal support for Slider objects.

uiltdlg uiltdlg.kb Internal support for tab dialogs.

uilroot uilroot.kb Definitions and API support for

navigation buttons.

Note These module dependencies are subject to change in future versions of

GUIDE/UIL.

This is the module hierarchy:

guidemo

guide

uil

guidesa

gms

guidelib

guislide

guitools g2cuidev




Removing Unneeded GUIDE Modules from an Application

Module Support for Navigation Buttons

Support for navigation buttons is provided by the modules uil and uilroot.
The uil module supports full navigation button functionality.

The uilroot module supports the creation, configuration, activation and deletion of
navigation buttons, but does not support other features, such as labels. Your G2
application can use only uilroot if it does not require that navigation buttons have
labels.

When GUIDE is loaded, you can create navigation buttons by cloning them from
the G2 GUIDE palette. When GUIDE is not loaded, you can create navigation
buttons by selecting New Object from the KB Workspace menu.

Removing Unneeded GUIDE Modules from an
Application

GUIDE/UIL is highly modularized, enabling you to deliver your deployed
applications with only those parts of GUIDE/UIL that your applications require.

After you develop a user interface using GUIDE/UIL, you can remove the
GUIDE modules that your KB no longer needs by selecting the following from the
GUIDE menu bar:

Tools > Remove GUIDE Application

This command removes all modules used by GUIDE that are not directly required
by other modules in your KB. Thus, it is important that you correctly modularize
your KB before you select this menu choice.

For example, if your application makes use of dialogs and most of the other UIL
components, your module must list uil as one of its directly required modules.
However, if you application uses only scroll areas, then uilsa is the only module
that it requires.

Choosing Remove GUIDE Application invokes the procedure uil-remove-guide-
application(). This procedure is public, and you can invoke it directly from your
GUIDE/UIL application. For information about this procedure, see the

G2 GUIDE/UIL Procedures Reference Manual.

You can also remove unneeded GUIDE modules individually, using the G2
Delete Module command. However, if you change the directly required module
list of any GUIDE or UIL module, be sure to save that module before you load
your application again. If you do not save the module before you reload your
application, the module will reload the same modules that you removed from its
list of directly required modules.

You can merge GUIDE development modules back into an application whenever
you need to modify or add features to the GUIDE user interface.
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Setting G2 Minimum Scheduling Parameter

For best performance of GUIDE/UIL, set the minimum-scheduling-interval in the
Timing Parameters system table to 0.25 or less.

For information about how to set this parameter, see the G2 Reference Manual.

Starting GUIDE

GUIDE is started when you start your knowledge base. You can start your
knowledge base by choosing Start or Restart from the G2 Main Menu.

When GUIDE is started, the G2 GUIDE/UIL initialization panel appears in the
lower left corner of the screen. The initialization panel includes the version
numbers for GUIDE and UIL and a changing display of status information about
the initialization process.

When the G2 GUIDE/UIL initialization panel disappears, initialization is
complete and you can use GUIDE.

Reinitializing GUIDE

You can reinitialize GUIDE by selecting the following from the GUIDe menu bar:
Tools > Reinitialize GUIDE

You can also use the UIL procedure uil-initialize-guide to initialize GUIDE.

Choosing a User Mode
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Before you begin to use GUIDE to develop a user interface, change your user
mode to Build mode. You can do this in either of two ways:

® Choose G2 > Change Mode > uil-build from the GUIDE menu bar.

® Select Build Mode in the GUIDE Control Panel. For information about how to
do this, see Using the GUIDE Control Panel.

When you use GUIDE in Build mode, the run-time behavior of dialogs and UIL
controls is suspended so that you can edit them. In Build mode, you can access
menu choices on dialogs and UIL controls by clicking on them. These menu
choices enable you to perform operations on the dialogs and UIL controls such as
moving, cloning, and deleting them, and accessing graphical editors through
which you can edit their attributes.

You can also create a user interface in Administrator mode, which gives you the
same access to the menus of dialogs and UIL controls that Build mode gives you.
However, Administrator mode lacks restrictions that allow you to use the G2



Using the GUIDE Menu Bar

GUIDE palette normally. Use Build mode when you create a user interface unless
you have a specific reason to use Administrator mode.

You can simulate the run-time behavior of UIL controls by changing your user
mode to User mode. In User mode, you enter text into edit boxes, selected and
deselect buttons, and scroll up and down in scroll areas. You cannot edit dialogs
or UIL controls in User mode.

Using the GUIDE Menu Bar

You can perform many GUIDE operations, such as creating objects and
displaying dialogs, through the GUIDE menu bar displayed across the top of the
window where you are running G2.

To include all GUIDE-specific menu options in the GUIDE menu bar, click the
Gensym logo in the upper-left corner of the window and choose GUIDE from the
menu:

G2 G2 Server - [NORWALK-N800C-2:1111]

File
v/ GUIDE

The menu bar and some new dialogs reached through the menu bar, depend on
the following G2 Developer’s Interface modules: g2uimenu, g2uifile, g2uiprint,
and g2uitree. these modules are required by the module g2cuidev. You may find
that you need to remove these KBs from GUIDE when you develop your
application.

ltem View Tools G2 Help

Removing g2cuidev.kb

If you edit GUIDE’s module hierarchy not to include g2cuidev. kb, you should
also disable GUIDE’s menu bar to prevent startup errors. You can reach that
menu bar with this Inspect command:

go to guide-menu-resource
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On this workspace, you will see a triangular template labeled k-guide. Disable
that item, and GUIDE will not attempt to show its menu bar upon startup.

D none =i kifle == kitem == kview = kilools =l kg2 =i k-help]
-guide

vooov b b

GeUI-MENU-FILE-5TUB GUIDE-MENU-VIEW-5TUB GUIDE-MENU-G2-STUB
GUIDE-MEMNLU-I TER-STUB GUIDE-MENU-TOOLE-STUB GUIDE-MEMU-HELP-STLUE

Reusing the GUIDE Submenus

All of the GUIDE submenus are usable by other menus. The GUIDE menu bar
template can be reached by using this Inspect command:

go to guide-menu-resource

The resulting workspace contains a copy of the G2 menu bar, with new, extended
submenus in place of the ones used by the G2 menu bar (except for the File menu,
which is untouched). All these GUIDE-specific menus can be reused by
customers’ menu bars, just as the GUIDE menu bar itself reuses the File submenu.
For more information about copying and reusing menus, see the G2 Developer’s
Interface User’s Guide.

Resetting the GUIDE Editor

You may want to reset GUIDE if you encounter problems during an editing
session. Resetting GUIDE returns it to its initial state at the beginning of your
editing session.

To reset GUIDE, select the following choice from the GUIDE menu bar:
Tools > Reset Editor

Enabling and Disabling GUIDE/UIL User Menu
Choices
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For certain basic operations, such as cloning or deleting, UIL objects have separate
versions of the G2 user menu choices.

The UIL user menu choices end in a period (.), to distinguish them from the
corresponding G2 user menu choices. For example, the UIL user menu choice for
cloning is clone., which except for the period is identical to the clone G2 user
menu choice for this operation.



Enabling and Disabling GUIDE/UIL User Menu Choices

If both the G2 and the UIL versions of a user menu choice are present in the menu
of a UIL object, always use the UIL version to perform the operation on the object.

Enabling and Disabling User Menu Choices for All
Objects

To enable user menu choices on UIL objects, toggle on the Enable User Menu
Choices toggle button in the More Options palette, which you can access through
the G2 GUIDE palette.

Enabling and Disabling User Menu Choices for
Particular Modules

You can enable or disable user menu choices for particular GUIDE/UIL modules
by setting the following logical parameters to true or false:

guide-user-menu-choices-active
g2uiprnt-user-menu-choices-active
guigfr-user-menu-choices-active
g2uifile-user-menu-choices-active
guidata-user-menu-choices-active
guimove-user-menu-choices-active
guislide-user-menu-choices-active
guidesa-user-menu-choices-active
uil-user-menu-choices-active
uilcombo-user-menu-choices-active
uilslide-user-menu-choices-active
uilsa-user-menu-choices-active
uiltdlg-user-menu-choices-active
uillib-user-menu-choices-for-non-uil-objects-active
uillib-user-menu-choices-for-uil-objects-active

By default, all these logical parameters are set to true. You disable user menu
choices for the objects in a particular module by setting the corresponding logical
parameter to false. For example, to disable user menu choices on Scroll Areas, set
uilsa-user-menu-choices-active to false.

Note that there are two logical parameters affecting user menu choices of the uillib
module:

¢ uillib-user-menu-choices-for-non-uil-objects-active true enables uillib user
menu choices on all objects; false disables uillib user menu choices for non-UIL
objects only.

* uillib-user-menu-choices-for-uil-objects-active true enables uillib user menu
choices on all objects; false disables uillib user menu choices for all objects.
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You can set the values of these logical parameters in an initially rule, a startup
procedure, or any other method that is suitable for your requirements. For
information about how to set the values of parameters, see the G2 Reference
Manual.

Using GFR Startup Objects

Note

Versions of GUIDE/UIL earlier than Version 4.1 depended upon initially rules to
initialize. This worked without problem unless other KBs loaded with
GUIDE/UIL had their own initialization procedures that could not run until
GUIDE/UIL finished initializing.

Because higher-level modules depend on the services of lower-level modules,
startup precedence becomes an issue in a multiple-module system. To ensure
correct operation, lower-level modules should be activated before higher-level
modules. GFR provides a startup facility that ensures that module initialization
activities proceed from low-level modules in an organized fashion up the module
hierarchy to higher-level modules. GFR also provides for organized dispatch to
multiple warmboot procedures following the loading of your KB from a snapshot
file.

The GFR KB provides a gfr-startup-object class to solve problems such as these.
Startup objects are assigned to modules (no more than one per module, though
some modules do not have any), and they contain references to procedures that
should be run when G2 is started. The order in which these procedures are run, if
there are multiple startup objects loaded at one time, is determined by the module
hierarchy: the lowest-level modules’ startup procedures are run first, on up the
hierarchy to the highest-level modules’ startup procedures last.

Startup objects can make it easier for KB developers to integrate GUIDE/UIL into
their KBs. A startup object can be created for the modules that depend on
GUIDE/ UIL; the startup procedures specified in those startup objects are
guaranteed to run after the GUIDE/UIL initialization has finished, with no need
to check for its completion. For more information on GFR startup objects, see the
G2 Foundation Resources Reference Manual.

GUIDE's startup object is in the uillib module, not in the guide module. It handles
initialization for all of GUIDE if the guide module is loaded.

Making UIL Controls Permanent
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By default, UIL controls are transient, and do not persist if you reset or restart
your KB.

If you need to make a UIL control permanent, use the UIL procedure uil-make-
grobj-permanent(). For information about this procedure, see the G2 GUIDE/UIL



Printing GUIDE Workspaces

Procedures Reference Manual.

Caution Do not attempt to use the G2 action make permanent to make UIL controls

permanent.

Printing GUIDE Workspaces

You can print GUIDE workspaces by choosing KB Workspace > Print from the
menu of the workspace that you want to print. The following dialog appears:

- Printer Destination
Mame: | UNSPECIFIEDBLARMN
| = I D Print to file
Server name: IUI\JSPECIFIED
Paper Size Scaling
LEDGER -
LEGAL ~ Scale to fit single page
LETTER ] & Manual scaling at | 100 workspace units per
hd INCH
- Copies Orientation Color
I ] EI ~ Landscape 4 Portrait @ Color
= =1 @ Black and white
-
i ~ Gray scale

’ Print | Cancel Options...
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To display additional print options, click the Options button in the Printer dialog.

The Print Options dialog appears:

Letft:

Right;

Taop:

Bottom:

— Format

03,
s

4 Postscript

~ Encapsulated Postscript

— Extras
E Print subworkspaces

[ Print in reverse order

E Echo print command

— Units
4 |nch
~ Centimeter

Print Options

— Margins

OK | Cancel

To select the printer on which you want to print your workspace, click the button
to the right of the Name field in the Printer dialog. The Select Printer dialog

appears:

Select Printer

— Printer

oK

Cancel

In the Select Printer dialog, a list of the currently configured printers appears in
the scroll area. Select the printer that you want to use and click the OK button.



Suggestions and Cautions

To select the server that you want to use, click the button to the right of the Server
Name field in the Printer dialog. The Select Server dialog appears:

Select Server

— Server

OK | Cancel

In the Select Server dialog, a list of the currently connected servers appears in the
scroll area. Select the server that you want to use and click the OK button.

Suggestions and Cautions

This section lists easy ways to avoid problems that can prevent you from running
or saving your GUIDE application.

* Always use GUIDE in a modularized KB.

The GUIDE dialog system works only in modularized KBs. Do not attempt to
use GUIDE in an unmodularized KB. For information about modularizing
KBs, see the G2 Reference Manual.

* Always name the top-level module of the application that uses GUIDE.

GUIDE incorporates the name of the top-level module into class definitions
and IDs that it generates automatically for internal use. GUIDE cannot
generate these class names and IDs if the top-level module has no name.

* Always merge GUIDE.

Always Merge GUIDE or any module that requires GUIDE or UIL. Do not
Load these modules.
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Restart after pause to merge in GUIDE.

Always restart your application after you pause to merge in the GUIDE
module or any module requiring GUIDE or UIL.

Do not reset your application after you pause G2 if dialogs are displayed. This
causes you to lose the dialogs. You can recover the dialogs by merging your
GUIDE application into your KB again.

Use GUIDE graphical editors to edit object attributes.

For most purposes, it is good practice to use GUIDE graphical editors to edit
the attribute values of dialogs or UIL controls.

It is possible to edit attribute values directly in the attribute tables. However,
if you edit the IDs or other attributes of dialogs and GUIDE controls directly
in attribute tables, you can introduce inconsistencies that prevent your
application from running properly.

Use GUIDE clone. menu choice to copy workspaces.

Always use the GUIDE clone. menu choice to copy workspaces. Problems
occur when you use the G2 clone menu choice to clone workspaces, especially
workspaces that contain a combination of UIL objects and non-UIL objects.

Do not use Operate On Area menu choice to clone or delete UIL objects.

Many UIL objects are composed of pieces held together by named relations or
internal lists. The Operate On Area menu choice is not designed to operate on
these features. Therefore, Do not use the Operate On Area menu choice to
clone or delete UIL objects.

Using Operate On Area to clone or delete objects produces UIL objects that do
not work properly. However, you can use Operate On Area to move and align
UIL objects.

Always use the user menu choices of UIL objects.

User menu choices end with a period (.). For example, always clone and delete
UIL objects using the clone. and delete. menu choices.

Close subworkspaces of dialogs before resetting GUIDE application.

Copy dialogs are lost if their subworkspaces are displayed when you reset
your application. To keep the copy dialogs, close them by clicking OK or
Cancel before you reset your application.



Suggestions and Cautions

Remove all UIL objects from a workspace before cloning or deleting the
workspace.

GUIDE does not properly clone or delete the UIL objects on a workspace
when you clone or delete the workspace.

Before you delete dialogs, delete copies of the dialogs from the dialog bin by
choosing delete copies from the dialog menus. If you do not delete the copies,
the copies remain in the bins after you delete the dialogs from the workspace.

Do not make master dialogs proprietary.

Master dialogs are templates that GUIDE clones to create the dialogs that
users see and use. Do not make master dialogs proprietary. Proprietary
dialogs cannot be cloned.

Do not make workspaces with master dialogs proprietary.

Do not make workspaces proprietary if they contain master dialogs or other
UIL objects. Proprietary workspaces are restricted to prevent cloning,
deleting, and certain kinds of text access. GUIDE dialogs fail to function when
placed on proprietary workspaces, because they make extensive use of clone
and delete operations.

However, you can place navigation buttons on proprietary workspaces.

Do not use clone workspace or delete workspace menu choices of a dialog
subworkspace.

Instead, use the menu choices for cloning or deleting the master dialog, not
the subworkspace of the master dialog.

Be careful not to delete the subworkspaces of master dialogs. Doing so makes
a master dialog unusable, because the subworkspace contains the dialog that
users see and use.

Check the value of uil-initialization-status parameter.

When the initialization of GUIDE is complete, GUIDE sets the value of the
symbolic parameter uil-initialization-status to initialized. The initial value of
this symbolic parameter is uninitialized.

Applications build on GUIDE should verify that the value of uil-initialization-
status is set to initialized before attempting to use GUIDE.

Do not use the string scroll-area in module names.

Module names that include the string scroll-area can conflict with names that
GUIDE generates automatically for internal use.

Limit number of named UIL controls as required to conserve memory.

Names of UIL controls are stored as symbols, and G2 does not reclaim
symbols. For this reason, you may want to limit number of named UIL
controls that you add to your user interface. Names are optional for all UIL
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controls except radio buttons and check buttons, which are automatically
named by the selection boxes that contain them. Thus, you may want to limit
the number of UIL controls to which you give optional names, or the number
of selection boxes that you add to your user interface.



Creating a
User Interface

Chapter 3: Generating Master Dialogs

Describes how to use the GUIDE Dialog Generator to generate a master dialog for viewing
and editing attributes of a particular user-defined class.

Chapter 4: Building Master Dialogs

Describes how to use the G2 GUIDE Palette and other GUIDE tools to build customized
dialogs for viewing and editing the class-specific attributes of user-defined classes.

Chapter 5: Using UIL Controls on a Workspace

Illustrates several ways to use UIL controls on a workspace, without incorporating them into
a dialog.

Chapter 6: Customizing Dialogs

Describes how to edit and customize GUIDE dialogs.

Chapter 7: Launching Dialogs

Describes how to launch a dialog from an action button, a user-menu choice, a user-defined
procedure, a push button, or a rule.

Chapter 8: System-Defined Dialogs

Describes the predefined message, confirmation, query, and notification dialogs and delay
notification icon.

43



44



Generating
Master Dialogs

Describes how to use the GUIDE Dialog Generator to generate a master dialog for
viewing and editing attributes of a particular user-defined class.

Introduction 45

Using the GUIDE Dialog Generator 46

Steps for Generating a Master Dialog 48

Launching Generated Dialogs from Push Buttons 59

Editing Generated Dialogs 61

gensym.

Introduction

Master dialogs serve as templates for dialogs that users see and use when they
run a G2 application.

For information about how to build more fully customized master dialogs, using
the G2 GUIDE Palette, see Building Master Dialogs.

Note You cannot use the push buttons and other UIL controls on a master dialog. To
test a master dialog and the UIL controls that it contains, you must launch a copy
dialog of the master dialog. For information about how to do this, see Launching

Dialogs.
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Using the GUIDE Dialog Generator

You can start the GUIDE Dialog Generator by choosing generate dialog from the
menu of the user-defined class for which you want to generate the dialog.

You can also start the GUIDE Dialog Generator by selecting Tools > Dialog
Generator from the GUIDE menu bar.

You can also start the GUIDE Dialog Generator by clicking on the question mark
(?) icon on the G2 GUIDE Palette. This opens the GUIDE Help dialog. In the
GUIDE Help dialog, click the button labeled GUIDE Dialog Generator.

When you generate a dialog, you can either allow GUIDE to choose, by default,
the classes of UIL controls that best represent the different class-specific
attributes, or you can override GUIDE’s default choices and use non-default
classes of UIL controls to represent some or all of the attributes.

Master Dialogs with Default UIL Controls

When you generate a master dialog with default UIL controls, you select the class-
specific attributes for which you want to add UIL controls to the dialog. To
represent each attribute, GUIDE uses a UIL control of the class that is best suited
for representing data of the type associated with that attribute.

The following table summarizes the kinds of UIL controls that GUIDE uses by
default to represent attributes with different data types.

Default UIL Controls for Attribute Data Types

Data Type of Example of Class- Default UIL Control for an
Class-specific specific Attribute Attribute of this Data Type
Attribute Definition
untyped color Edit box
color initially is red
truth value color is a truth-value, Icon toggle button. The
initially is true button’s default toggle

state reflects initially is
value in attribute

declaration.
symbol (with color is a symbol, has Icon toggle button. The
two possible values red or white, button’s default toggle
values) initially is red state reflects initially is
value in attribute
declaration.
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Using the GUIDE Dialog Generator

Default UIL Controls for Attribute Data Types

Data Type of

Example of Class-

Default UIL Control for an

Class-specific specific Attribute Attribute of this Data Type
Attribute Definition
symbol (with color is a symbol, has Radio box. By default, the

more than two
possible values)

values red, white, or
blue, initially is red

radio button representing
the initially is value in an
attribute declaration is
selected.

list, array

color is an instance of a
text-array

Scroll area. Elements of the
list or array are
represented by message
objects in the scroll area.

embedded
object

color is an instance of a
my-user-defined-class

Push button. You can edit
this push button to make it
open a dialog for editing
the attributes of the
embedded object, if such a
dialog exists.

other data types

color is a text, initially is
llredll

Edit box

The GUIDE Dialog Generator also automatically generates a user menu choice for
launching the master dialog. The user menu choice is added to every object of the
class for which you generated the master dialog.

Master Dialogs with non-Default UIL Controls

Generating a master dialog with non-default UIL controls is similar to generating

a dialog with default UIL controls. You select the class-specific attributes for

which you want to add UIL controls to the dialog, and GUIDE adds UIL controls
to represent these attributes.
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However, you can override GUIDE's default choices of UIL classes and use UIL
controls of other classes to represent some or all of the attributes. When you
generate a master dialog with non-default UIL controls, you can also:

® Generate user menu choices and push buttons for launching the dialog.

® Generate rules for updating the UIL controls on the dialog. You can generate
two kinds of rules:

- Rules for updating the display of an individual UIL control on the dialog
when its corresponding attribute receives a value.

- A rule for updating all UIL controls on a dialog when a user moves the
initiating object of the dialog. This rule can be useful for tracking the X and
Y coordinates of the initiating object.

Steps for Generating a Master Dialog

48

To generate a master dialog (with default or non-default UIL controls):
1 Change your user mode to either Build mode or Administrator mode.

Build mode is the recommended mode for constructing a user interface.
However, you can use all the features of GUIDE in either Build mode or
Administrator mode.

Note You may find it necessary to change to Administrator mode if certain modules
in your application can be accessed only by users who are running GUIDE in
Administrator mode.




Steps for Generating a Master Dialog

To change your mode, click the Mode button in the G2 GUIDE Palette.
Clicking the Mode button opens the GUIDE Control Panel:

E Mode... l\ About... |

Mavigation Buttons

A EEEEE

Selection Buttons
® —_—

m—
s—| ¢ |[e=|[H
Toggle Button Push Button

DI:I D E GUIDE Control Panel

Text [TEXT Edit Boxes Select Style .. .. . Size
= i Small
lMessage * Motf & .
E— = Ve ® Medun
- Large
Scroll Areas
o [~ Select Mode
h4 b # Build Mode
141 ]

o Uzer Mode:
! < Administrator Mode
Dialogs ﬁ

|| TITLE | [Oooo| [ooo oK | Apply | Cancel |

Borders Separators

EEE = —

e

] || e || [ ]

Sliders
=

E More Options

In the GUIDE Control Panel, select Build Mode or Administrator Mode, and
click OK.

Note If you are currently running GUIDE in Administrator mode, you can open the

GUIDE Control Panel dialog by clicking the Mode button and choosing select
from the Mode button’s menu.
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2 Open the attribute table of the user-defined class to make sure that it has

4

values for:
¢ Class-name
¢ Direct-superior-classes

* Class-specific-attributes (This slot defines the attributes for which GUIDE
can add a UIL control to the dialog.)

If any of these slots are empty, fill them with appropriate values.
Choose generate dialog from the menu of the user-defined class.
The GUIDE Dialog Generator appears.

For example, suppose that you choose generate dialog from the menu of a
user-defined class named cars, which has the class-specific attributes make,
model, year, color, and extras. The GUIDE Dialog Generator looks like this:

GUIDE Dialog Generator |
User Defined Classes: Attributes:
I | |- =
L model —
year
color
exfras
Select Al Attributes|
] ||
Add Class: |, Ial s
Include All User Defined Classes | oK |

In the User Defined Classes column, select the name of the user-defined class
for which you want to generate a dialog.

If you start the GUIDE Dialog Generator by choosing generate dialog from the
menu of a user-defined class, the name of the user-defined class appears
selected in the User Defined Classes column, as in the figure above.

If you start the GUIDE Dialog Generator from the GUIDE Help dialog, the
User Defined Classes column appears empty. You can select the class for
which you want to generate a dialog by entering its name in the Add Class
field and then clicking the up arrow. The name of the class appears selected in
the User Defined Classes column.



Steps for Generating a Master Dialog

You can also click the Include All User Defined Classes button to display the
names of all user-defined classes in the User Defined Classes column. You can
then select the name of the class for which you want to generate a dialog.

When a class in the User Defined Classes column is selected, the class-specific
attributes of that class are displayed in the Attributes column.

In the Attributes column, select the class-specific attributes that you want
users to be able to view and edit through the generated dialog. GUIDE adds a
UIL control to the dialog for each attribute that you select.

You can select individual attributes by clicking on them. You can select all
attributes by clicking on the Select All Attributes button.

The order of the selected attributes in the Attributes column determines the
order in which the UIL controls appear in the generated dialog. You can
change the order of the attribute in the Attributes column by dragging them
up or down.

When you select attributes, buttons labeled Customize Dialog and Generate
Dialog become enabled:

GUIDE Dialog Generator

User Defined Classes: Attributes:

B

make Customize Dialeg... |

model
Generate Dialog |

year

color

exlras

Select All Attributes|

[~
[~ Unselect Attributes |

Add Class: |, B
Include All User Defined Classes | OK |

At this point, you choose to generate either a master dialog with default UIL
controls or with non-default UIL controls:

® C(lick Customize Dialog to generate a master dialog with non-default UIL
controls.

® C(lick Generate Dialog to generate a master dialog with default UIL
controls.

The following sections explain how to generate each kind of dialog.
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Generating a Master Dialog with Default UIL

Controls

To generate a master dialog with default UIL controls:

1

Click the Generate Dialog button in the GUIDE Dialog Generator.

GUIDE creates a dialog and user menu choice, and places them on a
workspace. GUIDE creates a navigation button that you can click to go to this
workspace.

The navigation button is labeled class information. The dialog is named class
Information. The user menu choice is named edit class. In each of these names,
class is the name of the user-defined class for which you generated the dialog,.

To see the dialog and user menu choice, open the workspace.
To open the workspace, click the class information navigation button.

The following figure illustrates the navigation button, dialog, and user menu
choice generated for the user-defined cars class:

Master dialog

Cars Information

Cars Information

Workspace containing
master dialog and
user menu choice

"Cars Information”

o v o

=
|
|

edit-cars.-.-.

User menu choice

3 Launch the dialog to verify that it has the features you want.

To launch the dialog, select edit class on an object of the user-defined class for
which you generated the dialog.
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For example, if you select edit cars from the menu of an object of the cars
class, you launch the Cars Information dialog;:

A User-defined class

CARS

E G2 object of class cars

WY-CLD-CAR

bl Mike:

transfer

: IRAMBLER
hame Model:
clone Year |1955

rotate/reflect »

[_] Used false

change size
color . Color: # Brown
delete S
lift to top I

Extras:
drop to bottom air-conditioning =
disable power-brakes —
describe

. _ _ power-steering
describe configuration

create subworkspace rado =
move. . . ~|
edit array. . . oK | Apply Cancel |
edit cars. . . —

When the dialog is launched, each UIL control on the dialog is updated with
the current value of the corresponding attribute of the G2 object for which the
dialog is displayed.

Users can edit the values of the UIL controls and use standard OK, Apply, and
Cancel buttons on the dialog to apply or discard their edits. When a conclude
method is run on the dialog, each UIL control concludes its value to its
corresponding attribute of that G2 object.
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Generating a Master Dialog with Non-Default UIL

Controls

You can create a master dialog with non-default UIL controls. You can optionally
create a user menu choice push button, and/or rule for launching the dialog.

To create a master dialog with non-default UIL controls:

1

Click the Customize Dialog button in the GUIDE Dialog Generator.

A second GUIDE Dialog Generator window appears. You specify options for
the customized dialog in this window.

The following figure illustrates the GUIDE Dialog Generator when it has been
opened to create a customized dialog for the user-defined cars class:

GUIDE Dialog Generator

Title: ICars Information_ I

OpTiOI‘IS: Generate user-menu choice for launching dialog
[] Generate pushbutton for launching dialog
[[] Generate rules for updating dialog

Update from; 4 Initiating object
~ lemporary storage ohject

~ Mamed object

Aftribute Fields: UIL Control:

-

year uilicon-pushbutton
used uviicon-toggle-button
color uil-radio-box
extras uil-scroll-area
uil-text
uil-text-pushbutton
[~ [~]

Status:

OK | Apply | Cancel |
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In the Title field, specify a name for the new dialog.

By default, the name of the dialog is class information, where class is the name
of the user-defined class for which you are generating the dialog.

Choose the optional features that you want to generate.

To do this, select any combination of the following check buttons in the
Options group:

Generate user-menu choice for launching dialog
Generate push button for launching dialog

If you choose to launch a generated dialog from a push button, you must
specify the source and target objects and attributes for the UIL controls on
the dialog. For information about how to do this, see Launching
Generated Dialogs from Push Buttons.

Generate rules for updating dialog

If you select Generate rules for updating dialog, a dialog named Generate
Update Rules appears when you click OK in the GUIDE Dialog Generator
dialog. The Generate Update Rules dialog enables you to specify the
particular rules that you want to generate. For information about how to
use the Generate Update Rules dialog, see step 7.

Specity the source object whose attribute values are updated into the UIL
controls on this dialog. To do this, select one of the following radio buttons in
the Update From group:

Initiating object
The initiating object is a G2 object that launches the dialog.

Specify Initiating object as the source object when you use a user-menu
choice to launch the dialog. In this case, the source object is the object from
whose menu a user selects edit class-name to launch the dialog, where
class-name is the name of the user-defined class.

It is possible to specify Initiating object as the source object when you use a
push button to launch the dialog. For information about how to do this,
see Launching Generated Dialogs from Push Buttons.

Temporary storage object

For information about how to use temporary storage objects, see Creating
Temporary Storage Obijects.

Named object

This object can be any named G2 object.
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If you select Initiating object, the initiating object is also, by default, the target
object to which the UIL controls on the dialog conclude their values. You can
edit the UIL controls to specify different target objects.

If you select Temporary storage object or Named object, you must edit each
UIL control to specify its target object.

For information about how to specify the source and target objects of UIL
controls, see Specifying Source and Target Obijects.

5 Select the kind of UIL control that you want to use in the dialog to represent
each class specific attribute of the G2 object, as follows:

a Select an attribute in the column labeled Attribute Fields.

b Select a UIL control in the column labeled UIL Control. A UIL control of
this class will be added to the dialog to represent the selected attribute.

For example, the following figure shows how to specify that the color
attribute is represented in the generated dialog by a scroll area:

Aftribute Fields: UIL Control:

make ; uvil-check-box ;
model — uil-edit-box -
year uvil-icon-pushbutton

used uvil-icon-toggle-button
_ uil-radio-box

vil-text

| | | uiktext-pushbutton

-] [~

¢ To change the kind of UIL control used to represent an attribute, first
select that attribute in the Attribute Fields column. The UIL control
currently associated with that attribute is automatically selected in the UIL
Control column. Then, in the UIL control column, select the UIL control
that you want to use in place of the currently selected one.

6 When you finish selecting options in the GUIDE Dialog Generator dialog,
click OK.
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If you chose to generate update rules, the Generate Update Rules dialog
appears when you click OK in the GUIDE Dialog Generator:

Aftributes to generate rules for:

color
extras

make

model

Select Al Attributes |

Unselect All Attributes |

Optional Update Rules:
When initiating ohject is moved by user

oK |

The Generate Update Rules dialog enables you to generate two kinds of rules:

Rules that update the state or value of individual UIL controls on the
dialog whenever the corresponding attributes in the source object receive
values.

A rule that updates the state or value of every UIL control on the dialog
whenever a user moves the initiating object of the dialog.

To specify which rules you want to generate, follow these steps:

a

(o

In the scroll area labeled Attribute to Generate Rules For, select each
attribute for which you want to generate a rule. To select all attributes,
click the Select All Attributes button.

Select the toggle button labeled When initiating object is moved by user to
generate a rule that updates all UIL controls on the dialog whenever a user
moves the initiating object.

Click the OK button.

Close the GUIDE Dialog Generator dialog by clicking on the OK button.

GUIDE generates the customized dialog and (optionally) a user menu choice,
push button, and update rules. It places these objects on a workspace.

GUIDE creates a navigation button that you can click to go to the workspace.
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9 Look at the workspace to make sure that it contains the dialog and any
optional features that you chose to generate.

For example, the following figure illustrates a workspace containing a
customized dialog, user menu choice, push button, and update rules, and the
navigation button generated to open this workspace.

User menu
choice

Master
dialog

Cars Information Customized

H Cars Information Customized

"Cars Information Customized”

| o

% edit-cars.--. Launch... | Push button

whenever any CARS G is moved by the

i o Update all UIL
user and when there exists a uil-dialog controls on dialog
UserD such that (the uil-dialog-in-use of |1 whenever user
UserD is true and G is the-object- moves initiating
initiating-dialog-activity-for UserD) then object.
start uil-update-dialog-for-initiating-object
(UserD, G)

whenever the MAKE of any CARS G
receives a value and when there exists a on dialog for Make
uvil-dialog UserD such that (the uil-dialog- | |  attribute whenever
in-use of UserD is true and G is the- Make attribute
object-initiating-dialog-activity-for UserD) receives a value.
then start uil-update-dialog-for-initiating-
object (UserD, Q)

Update UIL control

10 Launch the customized dialog to make sure that it contains all the features
that you want.

To do this, select the user menu choice edit class from a G2 object of the class
for which you generated the customized dialog.
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The following figure illustrates the customized dialog for the cars class:

a

CARS

A

MWY-OLD-CAR

table Make: | MASH

transfer

Model: IRAMBLER
name
clone Year: IW%E

rotate/reflect - [L] Used false

e |
delete il -
lift to top plue ~]
drop to bottom Extras: air-conditioning =
disable power-brakes —
describe power-steering

describe configuration =dio

create subworkspace E

move. . .
edit array. . .
edit cars. . . —1™

Apply | Cancel |

Launching Generated Dialogs from Push
Buttons

When you generate a dialog using the GUIDE Dialog Generator, you can also
generate a push button to launch the dialog.

When you use a push button to launch a dialog, you must designate specific
objects as the source objects for UIL controls on the dialog. In the GUIDE Dialog
Generator, you designate a default source object for all UIL controls on the
generated dialog. You do this by selecting Temporary storage object, Named
object, or Initiating object under the label Update from.

The object used as the source object must have class-specific attributes from
which the UIL controls on the dialog can be updated.
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Updating UIL Controls from the Initiating Object
When the Dialog is Launched by a Push Button

When you launch a dialog by a push button, that push button is the default
initiating object of the dialog.

When you use to a push button to launch a dialog, updating the UIL controls on
the dialog from a Temporary storage object or Named object presents no special
problems. However, updating the UIL controls from the Initiating object, in this
case, the push button itself, is not possible. A push button does not have class-
specific attributes from which the UIL controls can be updated.

For example, if you choose Initiating object under Update from when you generate
the Cars Information dialog in the example above, the source object and source
attribute of the Make edit box are defined as follows:

Uil event source object | initiating-object

Uilevent source attribute | make

A push button cannot be used as the source object of the Make edit box because it
does not have a make attribute (or any other class-specific attribute) from which
the Make edit box can be updated.

The GUIDE Dialog Generator reminds you that you cannot use a push button as a
source object. If you select the Generate pushbutton for launching dialog option
and you also specify Initiating object under Update From, you see the following
message when you click OK in the GUIDE Dialog Generator:

The default behavior for the
pushbutton to launch the dialog is
not correct when updating from the

@ initiating object. A user setup action

for the pushbutton will be required.

Please consult the GUIDE/UIL

documentation for further information.

oK |

In order to use the push button to launch a generated dialog that is updated from
its initiating object, you must specify an object other than the push button itself to
use as the initiating object. The object that you specify as the initiating object must
have class-specific attributes from which UIL controls on the generated dialog can
be updated.

To designate a object other than the push button as the initiating object, you can
create a customized action that designates a new initiating object.
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Using an Action to Specify an Initiating Object

You can create an action that designates an object other than the push button itself
as the initiating object. You then add this action to the list of actions that are run
when a user clicks on the push button.

A user-defined action can designate an initiating object in two ways:

® The action can call the UIL procedure uil-override-initiating-object-for-dialog to
specify some object other than the push button as the initiating object of the
dialog. In the action, specify:

call uil-override-initiating-object-for-dialog(object, dialog)

where object is the object to use as the initiating object, and dialog is the
generated dialog that the push button launches.

® The action can use the following conclude statement to specify some object
other than the push button as the initiating object of the dialog;:

conclude that the-object-initiating-dialog-activity-for dialog is object

where dialog is the generated dialog that the push button launches and object
is the object to use as the initiating object.

For information about how to add an action to the list of actions run by a push
button, see Push Buttons.

Note In a push button’s list of actions, you must include the action that designates a
new initiating object before uil-call-update-method action or any other action that
you use to update the dialog.

Editing Generated Dialogs

For many purposes, your application can use generated dialogs without
modification. However, GUIDE enables you to edit generated dialogs to change
their appearance, contents, and behavior. The following table lists the chapters in
this guide that describe how to edit dialogs and UIL controls:

References to Information about Editing Dialogs

Editing Operation Reference

Allow more than one copy of the Dialog Options Dialog
generated dialog to be used on the
same G2 window.

Change the contents, layout, or Building Master Dialogs
appearance of a dialog.
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References to Information about Editing Dialogs

Editing Operation

Reference

Edit the appearance or behavior of a
UIL control.

The chapter that describes
UIL controls of that class.
For example, see Push
Buttons, for information
about how to edit a push
button.

Edit the value of a class-specific
attribute that is declared as an array
or a list.

Specifying Initial Contents

of an Array or List
Attribute

Specify the G2 object from which a
UIL control is updated or to which it
concludes its value.

Specifying Source
and Target Objects

Specify formats and validation
criteria for UIL controls.

Formats and
Validation Criteria

Specity edit styles for edit boxes.

Edit Boxes, Combo Boxes,
and Spin Controls




Building
Master Dialogs

Describes how to use the G2 GUIDE Palette and other GUIDE tools to build
customized dialogs for viewing and editing the class-specific attributes of user-
defined classes.

Introduction 64

Using the GUIDE Palette 64

Steps for Building a Master Dialog 67

Editing a Tab Dialog 77

Manipulating UIL Controls through User Menu Choices 82
Moving UIL Controls 84

Resizing UIL Controls 86

Transferring UIL Controls 86

Specifying Initial Contents of Text Objects, Message Objects, and Edit Boxes 86
Specifying Initial Contents of an Array or List Attribute 87
Specifying Source and Target Attributes of UIL Controls 89
Closing a Finished Subworkspace 89

Creating a Customized Dialog Programmatically 90

gensym.
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Introduction

You can use the GUIDE palette and other GUIDE tools to build customized

master dialogs for viewing and editing the class-specific attributes of user-defined
classes.

The tools described in this chapter enable you to:

® Create a master dialog and add UIL controls to it.
® Create and edit a master tab dialog.

* Add UIL controls to an existing master dialog.

* Customize the layout and appearance of a master dialog.

Using the GUIDE Palette

64

The GUIDE palette is your basic tool for building a customized master dialog.
Through the GUIDE palette, you can access the tools that you need to create a
master dialog and add UIL controls to it.

If the GUIDE palette is not visible, you can open it by selecting the following
choice from the GUIDE menu bar:

View > Palettes > GUIDE Palette



Using the GUIDE Palette

Tools Provided by the GUIDE Palette

The following figure illustrates the GUIDE palette and the tools that you can
access through it:

GUIDE Palette and Tools

E Mode... | About... | 7 UIL Procedure Lookup Facility D

Mavigation Buttons

jﬁ' UIL Meathods, Actions and Callbacks D
HEEEEEO

‘}'&' GUIDE Dialog Generator

Selection Buttons

g: <> %: |:| 9% UIL Examples

$— o—

¢ GUIDE Tutoral
Toggle Button  Push Button

DE Ij E ¢ GUIDE Debugging Tools
Text Edit Boxes Dismies

Message
[ T

= = =

Dismiss

GUIDE 8.3 Rev. 0 m GUIDE Information

KB Workspace Seleot Style . Size
i Small
Scroll Areas # o™ & T
a N Bl More Options I o Windows™ # Medum
hd ¥ e ¥ Large
hd hd

PRINT

Seleot Mode
D\a|095 ‘omnat Specification # Buld Made
m ormo 4 User Mode:

o |

+§ Administrator Mode

-

!

Action Dezcription Array

Borders Separators

EIEE0 —
EIEIEIE

0K | Apply | Cancell

o
5
=
g
£
£

=
—
Sliders
E E] |;} @ Configurations...
= : :
E More OpTiOI‘IS W] Erable User Menu Choices

The GUIDE palette includes the following tools:

Icons representing dialogs and the other classes of UIL controls. You use these
icons to create a master dialog and add UIL controls to it.

A Mode button, which opens the GUIDE Control Panel. You can use the
GUIDE Control Panel to select a user mode in which to run GUIDE, and to

specify defaults for the window style and size of objects created from the
GUIDE palette.
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Note

Only one copy of the GUIDE Control Panel dialog can be opened and used in
each G2 window. However, users on different G2 windows can open and use
different copies of the GUIDE Control Panel dialog.

An About button, which opens the GUIDE Information dialog. This dialog
tells you which versions of GUIDE and UIL are currently running.

A Help button, which opens the GUIDE Help dialog. The GUIDE Help dialog
enables you to:

- Display argument signatures and return values of UIL procedures
- Open dialogs for creating customized methods, actions, and callbacks
- Start the GUIDE Dialog Generator

- Go to a workspace that contains working GUIDE examples from the
GUIDE Demo KB (guidemo. kb)

- Start the GUIDE Tutorial, which leads you through the steps for creating a
GUIDE user interface.

For information about the GUIDE Help dialog, see Help Dialog.

A More Options navigation button. Clicking on this button opens the More
Options palette, which contains icons that you can select and drop to create
the following resources:

- A Print button. Users can click the Print button to open the Printer Setup
Dialog. In this dialog, users can specify options for printing the workspace
that contains the Print button.

- A reusable Format that specifies aspects of format such as the use of
quotation marks, capitalization, and hyphens. You can apply Formats to
edit boxes, text objects, and message objects. Formats can also specify
validation criteria for edit boxes. For information about formats, see
Formats and Validation Criteria..

- An action description array. An action description array is a list of
procedures that perform operations on a dialog. You can invoke an action
description array on a dialog by invoking the procedure uil-control-dialog-
callback. For information about action description arrays, see Controlling
Dialogs with Actions.

- Avreusable field edit style that specifies the behavior of the editor for edit
boxes. You can apply field edit styles to individual edit boxes. For
information about field edit styles, see Edit Styles for Edit Boxes.
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Steps for Building a Master Dialog

The following sections describe the steps that you must follow to build a master

dialog using the GUIDE palette and other tools.

Note You cannot use the push buttons and other UIL controls on a master dialog. To
test a master dialog and the UIL controls that it contains, you must launch a copy
dialog of the master dialog. For information about how to do this, see Launching

Dialogs.

Change your user mode to Build Mode.

To change your mode, click the Mode button in the GUIDE palette. Clicking
Mode opens the GUIDE Control Panel:

GUIDE Control Panel

Select Style . . . .. Size
& Matifm & Small
& WWindows™ # Medium
« Large

Select Mode
-~ Build Mode

- User hMode: |

# Administrator Mode

OK | Apply | Cancel

In the GUIDE Control Panel, select Build Mode and click OK.

If you are currently running GUIDE in Administrator Mode, you can open the
GUIDE Control Panel dialog by clicking on the Mode button and choosing
select from the Mode button’s menu.

You can also use all the features of GUIDE in Administrator Mode. However,
Build Mode is the recommended mode for constructing a GUIDE user
interface.

Set defaults for the size (small, medium, or large) and window style (Motif™
or Windows™) of UIL controls that you subsequently add to the master
dialog. The default size and style do not apply to UIL controls already on the
master dialog.
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You set the default size and window style In the GUIDE Control Panel.

Select Motif or Windows in the group of buttons under the label Select Style.
The following figure illustrates several buttons in each of these styles:

dio-butt |
< radio-button start

Motif ~ radio-button
3 .
< radio-button [L]off

(O radio-button start

Windows < (D radio-button
O radio-button ] off

Select Small, Medium, or Large in the group of buttons under the label Size.
The following figure illustrates a push button in each of these sizes:

small | medium large |

You can change the size of a UIL control after you have created it using the
GUIDE editor for that UIL control, or by selecting the G2 change size or
change min size menu choices.

The window style and size that you select in a GUIDE Control Panel apply
globally throughout the G2 knowledge base that you are using.

Note Labels of Motif-style buttons are contained in icons of these buttons. Labels of
Windows-style buttons are contained in separate UIL label objects. However,
any UIL procedure that operates on button labels has the same effect on both
Motif and Windows style buttons.

3 Click OK to apply the changes that you make in the GUIDE Control Panel.
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4 Create a master dialog using the GUIDE palette. You can do this in either of
two ways:

Select the dialog icon in the GUIDE palette for the style of master dialog
that you want to create (with or without tab pages) and drop iton a

workspace:

GUIDE 8.3 Rev. 0

E Mode... | About...|

Mavigation Buttons

ElAEEEEE]

Selection Buttons

| & [i=| =

Toggle Button Push Button

O] @

Text Edit Boxes
(=]

IWessage
L T BEC A
Scroll Areas

(4] B

[#] *

~ =
Cialogs

NON-TAB-DIALOGS

o | | |

o | | o I

[TITLE | oo

TAB-DIALOGS

Borders Separators

| E—
) [ ]
=== — =
Sliders

= =

E More Options

From the GUIDE menu bar, select one of the following;:

Item > GUIDE Objects > Dialogs > uil-tailored-dialog
Item > GUIDE Objects > Dialogs > uil-tab-dialog

Selecting this menu choice causes a master dialog icon to be attached to
your cursor. You can drop this icon on any workspace.
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5 Open the subworkspace of the new master dialog so that you can add UIL
controls to it.

To open the subworkspace, select go to subworkspace or show dialog from the
menu of the new dialog:

NON-TAB-DIALOGS

{ |/ o | ) )
Master Dialog Title
table

go to subworkspace ——
transfer

name

clone |

OK Apply Cancel

rotate/refle ot -

change size

color » A

delete

Subworkspace of

lift to top master dialog

drop to bottom

disable

describe

go to master dialey object
edit list. . .
edit configuration. . .

configurs

delete.

Mowe,

clone.

store copies in home kin
go to dialog hin
highlight copies

delete copies

initialize

show dialog
edit dialeg. ..

As shown in the figure above, the subworkspace of the new master dialog has
a title bar and three push buttons: OK, Apply, and Cancel. These push buttons
have appropriate default actions.

However, the subworkspace does not contain any of the UIL controls that
enable users to view and edit attributes of G2 objects. You must add these
components to the subworkspace, using the GUIDE palette.
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for Building a Master Dialog

Note The title bar of every master dialog contains the word Master. If you do not
see Master in the title bar of a dialog subworkspace, that dialog is not a master
and you cannot edit it.

Add UIL cont

rols to the master dialog.

To add a UIL control to a master dialog, select the icon on the GUIDE palette
that represents the UIL control that you want to add and drop it on to the
subworkspace of the dialog.

The following figure illustrates the icons on the GUIDE palette:

Navigation

buttons
\

Selection box
of radio buttons

Individual
radio button

Icon toggle
button

Text toggle — |

button
Text object — |

Message
object

Scroll area —— |
containing
message objects

Dialog title

Borders —— |

— |-

- Print button

Navigation Buttons

S

Selection Buttons

=1

Lo ——
Toggle Button

=)

| Text—[TEXT]

Message

Scroll Areas

| —

[ e

Dialogs ==
550l 5o
Borders Separators
] [ 1
— e =
=EE | —
Sliders -
] | ] L ﬂ
. = =

Garbage pail

Selection box
of check
buttons

Individual check
button

Icon push
button

Text push
button

Single-line edit
box

Spin control box

Combo box

Multiple-line

edit box

Empty scroll
area

Dialog

Tab
Dialog

Tab Page

Separators

Sliders
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The following figure illustrates how to add an edit box to a dialog;:

E Mode... | About... |

Mavigation Buttons

e EI Et

Selection Buttons
& —— m—
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Toggle Button Push Button
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E More Options

You can add most classes of UIL controls to a master dialog simply by selecting
their icons and dropping them on the subworkspace of the master dialog. Before
you add UIL controls to a tab dialog, first select the tab page to which you want to
add the control. For information about how to do this, see Editing a Tab Dialog.

You must follow special steps to add dialog titles, selection buttons, and scroll

areas to master dialogs. The following sections describe how to add selection
buttons and scroll areas to master dialogs.
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Adding a Dialog Title

You can add dialog titles to master dialogs that do not have titles. To do this, you
select the Title icon and drop it on the subworkspace of the master dialog.

You cannot add a dialog title to a master dialog that has a title. However, you can
add them to master dialogs whose titles have been deleted.

Adding Radio Buttons and Check Buttons

Radio buttons and check buttons can be used only in selection boxes. To add
radio buttons or check buttons to a master dialog, you must first add a selection
box for radio buttons or check buttons. By default, selection boxes contain three
buttons.

You can then add radio buttons or check buttons to the existing selection box on
the master dialog. You cannot use radio buttons and check buttons in the same
selection box.

The following figure illustrates the icons on the GUIDE palette that represent
selection boxes, radio buttons, and check buttons:

Selection Buttons

g _ E _ D Individual check
& —0 ) ™ O—— buttons
N\ Check button
Radio button Individual radio selection box

selection box button
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The following figure illustrates how to add a selection box of radio buttons to a
master dialog:

GUIDE 8.3 Rev. 0
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To add a radio button or check button to a selection box, click the radio button or
check button icon on the GUIDE palette and drop it on or near the selection box.
The new radio button or check button is added at the bottom of the selection box.



Steps for Building a Master Dialog

Adding Scroll Areas and Message Objects

You can add message objects only to existing scroll areas on a master dialog.
Message objects can be used only in scroll areas.

The following figure illustrates the icons on the GUIDE palette that represent

scroll areas that contain message objects by default, and scroll area that contain no
message objects:

Scroll Area
Scroll area |EI ; Empty scroll
containing —— v area
message I [

objects
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The following figure illustrates how to add an empty scroll area to a master

dialog:
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Steps for Building a Master Dialog

The following figure illustrates how to add a message object to a scroll area on a
master dialog:
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Changing the Size of a Dialog Subworkspace

You can change the size of a dialog subworkspace by dragging the upper-right or
lower-left corner of the subworkspace. Drag on the corner of the subworkspace
immediately inside the subworkspace’s border.

You can also enlarge a dialog subworkspace by dragging a UIL control to the
edge of it. This enlarges the subworkspace in the direction in which you drag. As
you drag a UIL control away from the perimeter of the subworkspace, the border
remains tightly wrapped around the subworkspace.

77



Editing a Tab Dialog
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A tab dialog is a dialog of the subclass of uil-tailored-dialog that supports the
operation of tab pages on its subworkspace. Each tab page is an object of the
subclass of uil-grmes that provides a grouping for other objects.

A tab page contains objects by storing them into an item-list attribute of the tab
page. As the tab pushbutton is selected by the user, all of the contents of the tab
page are raised to the top and become visible.

Each operation that affects a tab page, such as move, clone, transfer, and delete,
also carries out that operation on the contents of the tab page.

A tab push button is a push button of the subclass of uil-text-pushbutton that lifts
the associated tab page to the top of the stack of tab pages. On a mouse-down
gesture, the tabbed button is selected. This style conforms to current window
standards.

The tab pages on a dialog are managed by a tab page group. There can be only
one tag page group on a tab dialog. If you add tab pages to a dialog, the tab pages
are automatically added to the tag page group on that dialog,.

Lifting a Tab Page to the Top of the Stack

To lift a tab page to the top of the stack, click the tab page. In build or
administrator mode, you can then choose the select menu choice, just as you
would for any UIL button. In any other mode, a single mouse click lifts that tab
page to the top.

Adding UIL Controls to a Tab Page

You can add UIL objects to a tab page on a master dialog in the same way that you
can add UIL objects to any dialog. You can place any G2 object, including UIL
objects, on the area of the dialog outside the stack of tab pages.

To add an object to a particular tab page:
1 Create the object and drop it manually onto the top page.

2 If the tab page to which you want to add an object is not currently the top
page, click the tab for that page to bring it to the top, then drop the object on
that tab page.

For example, to add a scroll area to a tab page labeled Page 2:
1 Select Page 2 by clicking on the button labeled Page 2.
2 Choose select from the menu.

3 Click the scroll area icon on the GUIDE palette and drag it on top of Page 2.



Editing a Tab Dialog

For example:

Master Dialog Title
Page 1 | Page 2 TPage 3 ]

OK | Apply | Cancel

Changing the Size and Labels of Tab Buttons

You can change the size and labels of tab buttons by editing attributes of the
buttons:

* To change the size of a tab button, change the value of the uil-size attribute to
one of: small, medium, or large.

* To change the label of a tab button, change the label attribute of the button to
the desired value. Enclose the label text in quotation marks ("").

By default, the button is automatically resized to fit the size of the new label.
You can enable or disable the automatic resizing of tab buttons by setting the
resize-to-fit-label attribute of the button to true or false.
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Changing the Placement of Tab Buttons

For any stack of tab pages, you can specify whether the tab buttons are placed on
the top, left, or right edge of the stack.

To change the placement of tab buttons:
1 Select rotate tab pushbuttons from the menu of a tab page or a tab pushbutton.

This user menu choice aligns the tab buttons across the top, left, or right side
of the tab pages on the dialog.

2  Open the attribute table of the master tab dialog, and in the uil-tab-page-
button-placement attribute, specify one of: top, left, or right.

The tab pages are aligned along the left or right or across the top of the dialog,
depending on the value that you specify for the uil-tab-page-button-placement
attribute.

The following figure illustrates the top, right, and left placement of tab buttons:
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Editing a Tab Dialog

Adding New Tab Pages

A new tabbed master dialog contains three tab pages by default. You can add any
number of tab pages to the dialog.

To add a tab page to a tab dialog, select the Tab Page icon on the GUIDE palette
and drop it onto the stack of tab pages in the master dialog subworkspace:
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The new tab page is added to the bottom of the stack. If necessary, the stack
automatically enlarges to fit the new tab page.
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Deleting a Tab Page

To delete a tab page, select the tab page or tab button and choose the delete. menu
choice. A confirmation dialog appears, asking you to confirm that you want to
delete the tab page.

Deleting a tab page deletes the tab page itself, its tab button, and any uil-grobj or
uil-grmes object on the tab page.

Cloning a Tab Page

To clone a tab page, select the tab page and choose the clone. menu choice. The
new tab page is placed at the bottom of the stack of tab pages on the dialog.

When you clone a tab page, you also clone the contents of the tab page.

Reordering Tab Pages

To move a tab page to a different place in the stack, drag that page’s tab button to
the desired position and release it. (In any user mode other than administrator, the
drag motion is constrained to move horizontally or vertically, depending on the
placement of the tab buttons.)

For example, to move Page 3 so that it is between pages 1 and 2, drag the tab on
Page 3 to where it is between the Page 1 tab and the Page 2 tab:

Master Dialog Title

J/Page 1 TPage 3 TPage 2 TPage 4]




Editing a Tab Dialog

Lifting and Dropping Tab Pages with non-UIL
Objects

When a tab page is lifted above or dropped below other tab pages, any UIL
objects on that tab page are lifted or dropped with it automatically. Tab pages are
raised and lowered using G2’s system procedures for dropping and lifting objects
on G2 workspaces.

However, any non-UIL objects on a tab page are not lifted or dropped with that
tab page automatically. To ensure that the non-UIL objects are lifted or dropped
with the tab pages, you must write user code that maintain these objects in the
tab-page-contents-list of the tab page, as well as support the lifting and dropping
of items on the G2 workspace.

Moving the Stack of Tab Pages

You can move the entire stack by dragging the page that is currently at the top of
the stack to the desired position. When you drop this page, the rest of the tab
pages follow.

Moving the tab pages retains the positions of objects on the tab pages relative to
those tab pages.

Resizing the Stack of Tab Pages

To change the size of a tab page:
1 Click the top tab page and select the change size menu choice.
2 Specify a new size for the top tab page.
The tab page is resized immediately.
3 Click the top tab page again and select the resize all tab pages menu choice.

All the other tab pages in the stack are resized to the same size as the top tab page.

Transferring Tab Pages

You can transfer a tab page to another master tab dialog by selecting the tab page
and choosing the transfer menu option.

You can transfer a tab page only to another master tab dialog. If you attempt to
transfer the tab page to any other location, the tab page is returned to its original
location.
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Manipulating UIL Controls through User Menu
Choices
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Dialogs and UIL controls have menus of choices that you can select to perform
operations on these objects, such as naming, rotating, transferring, deleting, and
moving them. You can also access the object editor for a UIL control through its
user menu. For example, to open the Edit Scroll Area dialog to edit a particular
scroll area, select edit scroll area from the scroll area’s user menu.

To use menus of dialogs and UIL controls, you must be running in Build Mode or
Administrator Mode.

To open the user menu of a UIL control, click the UIL control. You can then select
menu choices to perform operations on the UIL control.

The following figure illustrates the user menu of a scroll area:
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